
KISSfp FrontPage FTP Add-On

KISSfp is used to prepare a FrontPage-based Web site for uploading to a Host without Server 
Extensions, using an FTP tool. It saves space on your web host and reduces download time for your 
visitors.

KISSfp is an HTML post-processing tool: It reads your local Web, starting with a given Homepage, 
processes it and writes the output in the "Out-Web" directory. While processing, it does two separate 
things to reduce a FrontPage Web: A) Minimise the number of files & folders, and B) HTML 
Compression. Neither changes the appearance of pages.

Having processed your Web, KISSfp calls your favorite FTP tool for actual uploading. For example, 
NetLoad (http://www.aerosoft.com.au/netload/) is a very useful FTP tool, that automatically 
detects changed pages and synchronizes a local directory with a remote server.

A) Reduce Number of Files & Folders
If a web does not use FrontPage Run-Time Components, none of the _vti_* folders are usually 
needed on the web host. Thus, KISSfp can copy all files which are actually linked from a given 
homepage to an output directory, including pages and images linked from linked pages, and so on, 
but none of the "superfluous" files. The number of files is significantly reduced, because only those 
actually needed for end-user viewing are copied. Depending on the number of files, 30% - 40% can
be saved.

The output directory can then be uploaded by FTP to the web host. That web host does not need 
Server Extensions installed. Note that this also accelerates the uploading of your site by FTP, 
because fewer files need to be transferred.

B) HTML Compression
KISSfp can compress HTML. This is achieved by removing FrontPage's themes & bots comments,
useful only for editing but not for final viewing. This means less download time for your visitors!

Contact

In the Help menu, you will find a URL directly taking you to the KISSfp site, where you will find Support, 
Registration options and helpful hints. The site also has instructions on how you can earn money by 
becoming a KISSfp reseller!

Author: Michael Vorburger (alpha ware) <ASP>
Switzerland



What's New in KISSfp 2.1a?

The following features have been added and bugs fixed in KISSfp 2.1a:

·[2.0a] Bugfix: HTML comments inside CSS <style> are not removed anymore.
·[2.0a] Time-limited evaluation version

·"Check for latest Version" in Help menu (on-line)
·automatically copy leave-site.gif & mail-to.gif icons to /Images
·FP2000: crawling improved (all <param ... valuetype="ref">)
·correctly handles SaveResults Bot (ERROR #30)
·testing and documentation of image MAPs
·fixed ".kissfp does not seem to be an HTML..."
·fixed "nedstat" bug introduced with 2.0b
·better startup logic to find LRU Web
·help text extended & updated
·EXE distribution uses Authenticode™ digital signature
·ZIP distribution now includes vendinfo.diz

...and many more bugfixes, detail improvements & updates!



What was New in KISSfp 2.0?

KISSfp 2.0 now comes as a real Windows application, with a GUI including FrontPage Integration, this 
OnLine-Help, Installer (SETUP.EXE) as well as two new features, and many detail improvements and 
fixes.

· New Features
· %URL%
· <!-- INSERT: {HTML} -->

· Improved Warnings
· new warning if URL contains troublesome special characters.
· new warning if URL contains whitespace. (Automatically corrected.)
· new warning if empty URL encountered. (e.g. href="")
· new warning if link contains special characters like bracket or space!
· new usability hint, if mailto-link does not show e-mail address in visible part.
· new warning for possibly invalid e-mail mailto links, e.g. containing %20.

· Improved Crawling
· Image maps (AREA) are crawled as well.
· META/Refresh is crawled as well.
· absolute links (starting with /) crawled as well.
· directory links (ending in /) crawled as well, including <a href="./">
· <!--#include virtual= crawled as well.
· <form ... action=...CGI... crawled as well.
· <TABLE background=> is crawled as well
· bugfix for # in APPLET/PARAM, e.g. <param name="url" value="other.htm#orgs" ...>

· Improved HTML Compression, increases another 5% on a site that uses themes!
· HTML Compression improved by removing useless <font ...></font> pairs.
· remove useless FONT e.g. <FONT><IMG...></FONT>
· replace <STRONG> by <B> and <EM> by <I> (of course also /strong and /EM)
· remove stylesrc="_private/style.htm" attribute (FP spec) in <body> tag. 
· no whitespace compression etc. inside any <tag> ("quoted" arguments!)

· Icons feature improved
· better ALT text for –icons
· doesn't insert leave-site icons after external link containing only IMG, e.g. Banners!

· Various
· conversion of chars >127 to character entities was dropped.
· replace ` by ' (if not already done)
· replace (TM) (C) (R) by numeric codes (&#153;) instead of &trade; etc.
· ASP and other HTML file-extensions correctly supported.



Main Window

Using KISSfp is straightforward:

· Select the Homepage by clicking on the corresponding button or typing a local file in the edit field. 
Select the Out-Web Directory by typing a local path (without file) in the corresponding edit field, or 
click the button to select any file in the output directory. (The selected filename is removed, only the
path is used.)

· Then press the (long) button "KISS Web..." and sit back while KISSfp processes your Web. After 
the Processing window disappears, the statistics are shown. If the menu "Extras/Show LOG" is 
selected, the LOG File pops up automatically. If not, you can click on "Show Log" to open it.

· If the menu "Extras/Start FTP" is selected, your favourite FTP tool (menu "Extras/Locate FTP tool")
is launched automatically. If not, start it by clicking on the button "Start FTP..." if desired. Then 
upload to or synchronize the Out-Web Directory with your Web host by FTP, for example using 
NetLoad  http://www.aerosoft.com.au/netload, a very useful FTP tool, that automatically 
detects changed pages and synchronizes a local directory with a remote server.

The settings are stored on a per-Homepage basis in a configuration file in the same directory as the 
selected homepage, with the same filename, but with the ending ".kissfp". Opening (double-click) .kissfp 
files will start KISSfp. (Note there is no need for an explicit Save operation for the configuration file.)

see also
· FrontPage Integration
· CLI Version



The CLI Console Version of KISSfp

In addition to the Windows GUI Interface, a CLI version of KISSfp is available for advanced users. The 
following are all options and switches in the command-line version, kissfp.exe:

-icons causes KISSfp to insert the leave-site and mail-to icons. Corresponds to the 
respective setting in the Extras menu of the GUI version.

-overwrite runs KISSfp in now unsupported Overwrite Mode, for usage with Servers that DO 
have FrontPage Server Extensions. BEWARE, THIS CAN DESTROY YOUR WEB 
IF NOT USED CORRECTLY.

-touch sets the current date/time to all written pages. Without this option and in the GUI, 
KISSfp resets the date/time of the output pages to the date/time of the respective 
input page.

-verbose runs KISSfp in "verbose mode", that is it prints various messages while processing 
files; this is useful for debugging.

In KISSfp 1.x, the option -leavechars existed. Even though still accepted, the option no longer 
changes KISSfp's behaviour in v2.x, because -leavechars is always on.

USAGE

1. Call KISSfp with the DOS path (not URL) of the homepage of the respective web as the first 
argument, and the output directory for the compressed site as the second. NB: Don't confuse 
FrontPage's Web directory and KISSfp's output directory: The second is only for uploading to 
your web host and not suited to editing.

 
2. KISSfp copies only the really necessary files including graphics to the output directory. HTML 

documents get compressed. Existing files are overwritten only if they are older and the 
date/time of output files is reset to the input file, unless you specify "-touch" as the third 
argument. (If you remove or rename files in your web, use -touch or delete the entire output 
directory so that it is rebuilt.)

 
3. Upload the output directory via FTP to your web host.



LOG Messages

These are the Warning and Error messages that KISSfp might issue:

· ERROR #9: Could not read X referenced by Y. Broken Hyperlink?
· ERROR #6: URL X in file Y is very similar to the URL X' which occurred in Y', except that 

upper-/lowercase is different. Problems on UNIX webservers!
· ERROR #20: File X referenced by Y has different upper-/lowercase on disk.
· WARNING #1: URL X starts at root directory (/). This is discouraged. (Link ignored)
· ERROR #3: URL X in file Y contains a backslash '\\' character. (Link ignored)
· ERROR #4: URL X in file Y leads out of the root directory
· ERROR #5: URL X in file Y contains dots ('.') after '\' the relative part. (Link ignored)
· WARNING #10: X uses Unknown Scripting. Cannot copied referenced files.
· WARNING #13: X includes Java Applet Y - cannot know which classes to also copy.
· ERROR #17: File X is already post-processed by KISSfp! Maybe forgot to Re-Publish.
· WARNING #21: URL X in file Y links local file! (Link ignored)
· ERROR #22: URL X in file Y contains special character! (Link ignored)
· HINT #23: In X the mailto-link Y should show X instead.
· WARNING #24: An URL in file X contains WHITESPACE! This was corrected.
· WARNING #26: Document X contains an EMPTY URL.
· WARNING #27: In X, Y (A HREF mailto:) doesn't seem to be a valid e-mail address.

... and a lot more, of little interest here. (system errors)



Insert mail-to & leave-site Icons

KISSfp (Registered Version only) can insert tiny icons after e-mail links and links leaving your site, if this 
option is enabled in the Extras menu (GUI) or the -icons switch (CLI) is given.

The GUI version automatically copies the two icons named mail-to.gif  & leave-site.gif
 from the KISSfp installation directory (e.g. C:\Program Files\KISSfp) to the top-level /images directory

of your Web. If you use the CLI version or there is a problem, please copy these two icons to the /images 
directory yourself, the first time only.

No space is inserted before the IMG, and the link closure </A> is placed after the image. This makes the 
icons clickable and does not generate an ugly underlined blank. The image should have a small left 
margin though, e.g. 5 pixels.



Replace %URL%

KISSfp replaces every occurrence of %URL% with the URL of the current page. It is generally 
recommended to show a page's original URL location on every page of your site. This makes it easier to 
find your site if the page is printed or e-mailed to somebody.

To do so, place a string like 
http://www.myhost.org/%URL%

in the shared bottom border of your site.

NOTE: FrontPage's Insert Location Bot cannot be used for this purpose because it inserts the 
local file path for file-based webs.



<!-- INSERT: {HTML} -->

This special comment is replaced by the content of {HTML}, removing the comment. This feature is 
useful because FrontPage and other HTML editors remove or modify certain special tags and 
constructions, which can be preserved with this feature.

For example, if you use an external counter, like <IMG src="http://usa.nedstat.net/..." ...
ALT="Counter"> then FrontPage will remove/reset this if it cannot find the host, because you are 
perhaps using a modem dial-in connection and are not always on-line.

Using <!-- INSERT: <IMG src="http://external.host.org" ... ALT="Counter"> --> 
will cause FrontPage to ignore the tag, and KISSfp will remove the comment, making your counter work 
correctly.

Other examples of where this feature proves to be useful:

· placing ALT text in client-side image maps, because FrontPage (98) strips out ALT attributes in 
client-side image maps.

· insertion of a real <HR> or <UL> tag and preventing its transformation into an IMG for pages that 
use a FrontPage Themes.

· banner exchange HTML insertion, the code must be inserted exactly as given

NOTE: {HTML} is not allowed to contain a closing comment --> as this is interpreted as the end of the 
initial comment sign.

This functionality is similar to FrontPage's InsertHTML Bot, but has a simpler syntax and useful 
to edit HTML in Notepad.



NOKISS Tag

If you want to disable KISSfp and automatic icons for some parts of an HTML document, embed the 
respective parts between <!-- NOKISS --> and <!-- /NOKISS --> in the HTML source.

When KISSfp encounters the NOKISS tag, no icons are automatically inserted, all KISSfp features are 
disabled, meaning no FrontPage bots are removed, and no whitespace compression takes place on the 
selection.

Inside FrontPage Editor, two new menu commands are added to the Insert menu which insert these 
special comment tags.

NOTE: Inside <!-- NOKISS --> ... <!-- /NOKISS --> any links (A/IMG etc) are NOT crawled!



FONT Fix Feature

Extends FONTs to include alternative Fonts for viewing your site on non-Windows platforms so that they 
degrade gracefully in such situations, according to the following substitution mapping:

Arial Arial, Helvetica
Arial Black Arial Black, Arial, Helvetica
Arial Rounded MT BoldArial Rounded MT Bold, Arial, Helvetica
Book Antiqua Book Antiqua, Times New Roman, Times
Bookman Old Style Bookman Old Style, Times New Roman, Times
Brush Script MT Brush Script MT, Arial, Helvetica
Century Gothic Century Gothic, Arial, Helvetica
Century Schoolbook Century Schoolbook, Times New Roman, Times
Comic Sans MS Comic Sans MS, Arial, Helvetica
Garamond Garamond, Times New Roman, Times
Haettenschweiler Haettenschweiler, Arial, Helvetica
Impact Impact, Arial, Helvetica
Times New Roman Times New Roman, Times
Trebuchet MS Trebuchet MS, Arial, Helvetica
Verdana Verdana, Arial, Helvetica

FrontPage itself does this correctly for (original) themes only, but setting a font directly in FrontPage 
Editor (Format Character) or importing a document leaves Arial as Arial only, and does not provide 
correct alternative fonts!
      
Additionally, miscapitalized common FONTs are fixed, as this can cause problems on some older 
browsers according to the Cut-N-Paste JavaScript newsletter: "We later found out that the names of fonts
in <FONT FACE="Yourfontname"> tags must be capitalized like 'Arial' not 'arial'."



FrontPage Run-Time Components

This page helps you to understand the difference between the two categories of FrontPage 
Components. Webs processed by KISSfp cannot use Run-Time Components, as they rely on 
Server Extensions. (Advanced users can still use KISSfp for HTML Compression only, in -overwrite
mode of the CLI version.)

There are two different categories of FrontPage Components, called WebBots in earlier versions of 
FrontPage: A) Authoring-time and B) Run-time components, the latter also called browse-time 
components in some of Microsoft's documentation.

A) Authoring-time components (Hover Button, PageBanner, NavBar, TOC, TimeStamp, 
Substitution, Marquee, Movies, "PurpleText" Comment, Banner Ad Manager, Include HTML) are 
called by FrontPage Editor when the page containing the component is being saved. They insert 
static HTML code in your page, which will be displayed as-is in the browser.

If your web uses only authoring-time components, there is no need for FrontPage Server Extensions to 
be installed. Upload by FTP is no problem in this case. Server space is saved by i) compressed HTML 
files, ii) absence of now useless _vti_ folders and iii) non-installed Server Extensions.

B) Run-time components (Hit Counter, Search Form, Run-Time Include Page 'Server', 
Scheduled Image and -Include, FP specific Forms: Discussion, Registration, Guestbook, Save 
Results Confirmation; Database & ASP) expand dynamically when the page containing the 
component is fetched by a browser and rely on the FrontPage Server Extensions.

If your web contains run-time components, you cannot upload it by FTP to any web host, but must 
publish it through FrontPage Explorer to a server with FrontPage Server Extensions installed.

KISSfp will analyse which category of FrontPage components your web uses and tell you if it can be 
uploaded by FTP to a server which does not have the FrontPage Server Extensions installed.

Note that using FrontPage Themes is 100% compatible with KISSfp, including active graphics which use
JavaScript. All the following FrontPage features should be compatible with KISSfp anyway: Common 
Borders, Document Templates, Cascading Style Sheets, CDF, Background Images & Sounds, etc.

see also
· Convert Server-based to File-based FrontPage Web
· Overwrite Mode
· Java & Scripts



Crawling Details

KISSfp starts to process your site from the given Homepage, then looks at all pages that are linked from 
it, then pages and images linked from linked pages, and so on.

Because KISSfp crawls through a site this way, you have to manually copy unreferred files (such as 
small index.html to "cover the directory") if they are needed. You may even need to run a separate copy 
of KISSfp for an entire "hidden" tree of files which cannot be reached from the given homepage. A future 
version of KISSfp might include a specific ORPHAN warning for such cases.

When crawling directory links (ending in /) KISSfp tries to find the page by checking for index, default & 
welcome with extensions htm?, shtm?, htx or asp.

Any URL containing ':' (http:// ftp:// mailto: news:) is considered to be absolute & external, and is therefore
not followed. NB: That implies that file:// is not followed either, and a warning is issued.

NOTE
Even though KISSfp does crawl and copy pages and images linked by e.g. Java applets and 
image maps, you should always provide "textual links" (A/HREF) to these pages as well, 
because:

· many of your site's visitors could have disabled Java for Speed/Security reasons
· many use still use older Browser, WebTVs, or text-only browsers such as Lynx
· all Search Engines such as AltaVista will NOT be able to browse your site, for the same 

reason KISSfp could have problems crawling some parts of it.
If you are interested to learn more about this issue called Accessibility, see 
http://www.w3c.org/WAI or http://www.webable.com

see also
· Image Maps
· Java & Scripts
· FrontPage Components



Register KISSfp

If you find KISSfp useful, please register it. Your registration will motivate me to work on more cool 
webtools. The unregistered version is fully functional, but disables the "Insert Icons" feature and inserts 
visible KISSfp advertisement in the HTML files it processes. Please note that you are not allowed to 
modify or remove the advertisements.

In the Help menu, you will find a URL directly taking you to the KISSfp site, where you will find 
Registration options. The site also has instructions on how you can earn money earn money by 
becoming a KISSfp reseller!



License Agreement

To use the KISSfp software, please first review and agree to this License Agreement:

KISSfp 2.x END-USER LICENSE STATEMENT AND LIMITED WARRANTY
Copyright (c) 1998-1999 by Michael Vorburger (alpha ware).    All Rights Reserved.

This End-User License Agreement (EULA) is a legal agreement between you (an individual or an entity, 
"User") and Michael Vorburger (alpha ware) for the software product KISSfp 2.x ("Software"), which 
includes the executable computer software program, electronic documentation and other files included in 
the distribution. By installing, copying, or otherwise using KISSfp, you are agreeing to be bound by the 
terms of this Agreement. If you do not agree to the terms of this Agreement, contact KISSfp Support for 
other licensing options, until the establishment of which you are not authorized to use this software. The 
Software is in "use" on a computer when it is loaded into temporary memory (i.e. RAM) or installed into 
permanent memory (e.g., hard disk, CD-ROM, or other storage device) of that computer. 

ALL VERSIONS

The KISSfp software is available in a FREE evaluation and commercial version. Both the evaluation and 
commercial versions are subject to the terms and conditions of this Agreement. The commercial version 
of the software requires payment by you of a license fee.    The evaluation version of the software is the 
only version that is provided without charge. The evaluation version is not free software and is subject to 
the restrictions set forth below.

This Software is protected by copyright laws and international copyright treaty provisions, as well as other
intellectual property laws and treaties. Therefore, you must treat KISSfp like any other copyrighted 
material. You may not use or copy KISSfp for any other purposes than those described in this Agreement.

This Software is owned by Michael Vorburger (alpha ware) who hereby grants to the user a temporary, 
non-exclusive license to use this Software solely for internal purposes. User shall not sell, commercially 
distribute, or use in any profit-oriented endeavor, copy, transfer for any consideration, or reproduce for 
any purpose, rent, lend, lease, time-share, or sub-license the Software or any modification or derivation 
thereof, either alone or in conjunction with any other products or programs, without the express 
permission of the author, with the exception that the KISSfp unregistered evaluation version may be 
distributed according to the conditions below. You may make copies of KISSfp for backup and archival 
purposes. 

Further, the user shall not disassemble, reverse engineer, modify, translate, decompile, create derivative 
works based upon the Software, remove any notices or labels of the Software in its output, or otherwise 
abuse the intended purpose under this License Agreement.

All trademarks used in the Help File and executable program are the property of their respective owners 
and are used for explanatory purposes only. This product includes software developed by the University 
of California, Berkeley and its contributors.

While Michael Vorburger (alpha ware) intends to provide upgrades for this Software, Michael Vorburger 
(alpha ware) reserves the right at any time to change prices, specifications, features, licensing terms, 
release dates, general availability or other characteristics without further notification to the user. Michael 
Vorburger (alpha ware) entirely reserves all rights not expressly granted.

UNREGISTERED EVALUATION VERSION LICENSE ("UNR")

You may try the FREE unregistered evaluation version of KISSfp without charge. The FREE unregistered 
evaluation version is fully functional, but inserts visible KISSfp advertisement in the HTML files it 



processes. YOU ARE NOT ALLOWED TO MODIFY OR REMOVE THE ADVERTISEMENTS.

If you find KISSfp useful, please register it according to the instructions provided on the KISSfp website, 
available through the application's Help menu.

KISSfp unregistered evaluation may be distributed freely via media intended to make software available 
to the public for trial, in the original package or archive form (kissfp2?.exe or kissfp2?.zip) or in any other 
form, as long as all files of the package are distributed in their entirety and no modification is made.

PRIVATE LICENSE - REGISTERED VERSION ("PVT")

After payment of the private version license fee, you receive a Registration Key which upgrades the 
software to private version. YOU ARE NOT ALLOWED UNDER ANY CIRCUMSTANCES TO 
DISTRIBUTE THE REGISTRATION KEY FILE.

The PVT version enables the cool "insert mail-to & leave-site icon" feature and does not insert visible 
advertisement, but a notice in the META/GENERATOR tag of the HTML files it processes. This notice is 
INVISIBLE to your site visitors in rendered HTML and can only be seen by looking at the HTML file source
code. YOU ARE NOT ALLOWED TO MODIFY OR REMOVE THIS NOTICE.

The private license is for non-commercial users processing non-commercial web-sites.

One copy of the private version of KISSfp software may either be used (1) by a single person who uses 
the software personally on one or more computers, or (2) by multiple people non-simultaneously on a 
single workstation, but not both.

BUSINESS LICENSE - REGISTERED VERSION ("BUS")

After payment of the business version license fee, you receive a Registration Key which upgrades the 
software to business version. YOU ARE NOT ALLOWED UNDER ANY CIRCUMSTANCES TO 
DISTRIBUTE THE REGISTRATION KEY FILE.

The business license is for commercial users processing commercial web sites. Additionally to all features
described above for the private license, it does not insert any notice in the HTML files it processes. The 
Business License gives you priority to receive replies to your support requests.

One copy of the business version of KISSfp software may be used by up to ten concurrent users.

UPGRADE & TRANSFER

If the software and related documentation are provided as an upgrade to an earlier licensed release of the
software, then you must have a valid license to operate such earlier release of the same version and 
edition as the upgrade to install or use the upgrade.    All software being upgraded is deemed to be part of 
the software and is subject to this Agreement.    You may transfer an upgrade only in conjunction and 
together with the licensed software being upgraded.

You may transfer the Licensed Software on a permanent basis, provided you retain no copies, and the 
recipient agrees to the terms of this License Agreement. Upon such transfer, your license under this 
License Agreement is automatically terminated. If the software and related documentation is an upgrade 
to an earlier licensed release of the software, any transfer must include all prior releases of the software 
and documentation.



DISCLAIMER OF WARRANTY

THE MATERIAL EMBODIED ON THIS SOFTWARE IS PROVIDED TO YOU "AS-IS" AND WITHOUT 
WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT 
LIMITATION, ANY WARRANTY OF MERCHANTABILITY, SATISFACTORY QUALITY, OR FITNESS FOR 
A PARTICULAR PURPOSE. IN NO EVENT SHALL Michael Vorburger (alpha ware) BE LIABLE TO YOU 
OR ANYONE ELSE FOR ANY DIRECT, SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL 
DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER, INCLUDING WITHOUT LIMITATION, 
LOSS OF PROFIT, LOSS OF USE, SAVINGS OR REVENUE, OR THE CLAIMS OF THIRD PARTIES, 
WHETHER OR NOT Michael Vorburger (alpha ware) HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH LOSS, HOWEVER CAUSED, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN 
CONNECTION WITH THE POSSESSION, USE OR PERFORMANCE OF THIS SOFTWARE.

Michael Vorburger (alpha ware) (i) DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTIES AS TO THE 
NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE 
SOFTWARE OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR 
ERROR-FREE; (ii) SHALL IN NO EVENT BE LIABLE TO YOU OR ANYONE ELSE FOR LOSS, INJURY 
OR DAMAGE CAUSED IN WHOLE OR PART BY, OR FAILURES, DELAYS OR INTERRUPTIONS OF, 
THE SOFTWARE; (iii) SHALL IN NO EVENT BE LIABLE TO YOU OR ANYONE ELSE FOR ANY 
DIRECT, CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES, INCLUDING BUT NOT LIMITED 
TO ANY LOST PROFITS OR TRADING LOSSES ARISING OUT OF OR RELATING TO THE USE OR 
INABILITY TO USE THE SOFTWARE OR ANY DECISION MADE OR ACTION TAKEN BY YOU IN 
RELIANCE ON THE SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.    
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH YOU 
AND SHOULD IT BE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF SERVICING, REPAIR OR 
CORRECTION OF SUCH DEFECTS.    

BECAUSE OF THE VARIOUS HARDWARE AND SOFTWARE ENVIRONMENTS INTO WHICH THIS 
PROGRAM MAY BE PUT, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS 
OFFERED. THE USER ASSUMES THE ENTIRE RISK OF USING THE PROGRAM.

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF WARRANTIES OR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSIONS 
MAY NOT APPLY TO YOU AND THEREFORE YOU ARE NOT GRANTED A LICENSE TO USE THIS 
SOFTWARE.

You acknowledge that you have read this agreement, understand it and agree to be bound by its terms 
and conditions. Your further agree that is it the complete and exclusive statement of the agreement and 
supersedes any proposal or prior communications between Michael Vorburger (alpha ware) and the User 
relating to the subject matter of this Agreement.

You can contact support for questions and comments on the KISSfp website,
available through the application's Help menu.

--- End of KISSfp 2.x License of April 25, 1999 (support for all licenses) ---
--- End of KISSfp 2.x License of April 5, 1999 (Proof-read & spell-check only) ---
--- End of KISSfp 2.0 License of January 12, 1999 (first version) ---



Using Java Applets & Script with KISSfp

The information given on this page is only of interest to those who want to understand how 
KISSfp chooses which files to copy, e.g. when you use your own components not supplied with 
FrontPage.

Java Applets, Scripts (JavaScript) and ActiveX Controls cause two problems for KISSfp when copying 
files to the output directory:

· Which additional files (e.g. images) have to be copied?
· Which referenced classes have to be copied?

The first question can be answered for all Java applets supplied with FrontPage, because FP inserts a 
(non HTML compliant) valuetype="ref" attribute in every <param> which represents a needed file, e.g. an
image which will be loaded.

A similar 'trick' holds for the JavaScript used in the "Active Graphics" feature, which loads different 
versions of graphical buttons in some themes: KISSfp loads all images referenced in MSFPpreload 
function calls. (Note that Active Graphics are similar to the Hover-Button Component, but implemented in 
JavaScript instead Java.)

An example for the second question: fphover.class needs fphoverx.class. The current version of KISSfp 
has a built-in table of the dependencies of the Java classes supplied with FrontPage and correctly copies
classes. (A future version of KISSfp could parse the Java class files to recognise all dependencies 
automatically. Let me know if that would be useful for you.)

If you use Java applets or Scripts not supplied with FrontPage in your site, make sure you manually copy
all files and classes needed to the corresponding KISSfp output directory. For Java applets, you can 
comply with the valuetype="ref" convention to tell KISSfp which files to copy. 



Overwrite mode

Advanced users can use KISSfp (CLI Version only) to locally postprocess a Web using Run-
Time Components just for HTML Compression, neat Icon and interest in the warnings; but 
still published through FrontPage and not by FTP.

BEWARE: THIS PROCEDURE CAN DESTROY YOUR WEB IF NOT USED CORRECTLY.

USAGE

1. You have to create a server-based local copy of your web by publishing it through FrontPage 
Explorer to another location. Disable option 'Copy Only Changes'. Do NOT xcopy (DOS) or 
copy through Windows Explorer!

 
2. Call kissfp.exe (CLI) with "-overwrite" as the first argument and the DOS path (not URL) of

the copied homepage as the second.
 
3. KISSfp compresses and overwrites the HTML documents in the copied web. No files need to 

be copied. A log-file is generated and one statistic is shown at the end.
 
4. Publish the copied and now compressed web through FrontPage Explorer, as usual.

BEWARE: You have to copy the web and keep further work with the original. The copied web is 
not well-suited for later re-editing because Bot Comments are removed.)



FrontPage Integration

KISSfp installs itself into FrontPage 98 Explorer's first menu, File. Right above "FrontPage Web 
Publish..." there now is "FrontPage Web KISSfp for FTP..." which starts KISSfp.

In FrontPage 2000, KISSfp appears in the special Third-Party Add-On's menu.

When KISSfp starts up (with no argument) while FrontPage is running, it asks FrontPage Explorer 
about the currently open Web and opens the Homepage. This only works if the Web is file-based. (Uses 
OLE Automation)

Inside FrontPage Editor, two new menu commands are added to the Insert menu which insert the 
special NOKISS comment tags.



Convert Server-based to File-based FrontPage Web

KISSfp strongly recommends to work file-based if your Web does not use Run-time 
Components. This considerably speeds up things.

Here's how to convert a Server-based FrontPage Web to a File-based Web:

 A) When creating a new web in FrontPage Explorer, click Change and just type a file path such as C:\
myweb instead of a server such as http://localhost/ as suggested.

    
 B) If you already have a server-based web, convert it to a file-based one:

1. Create a New Empty Web. Close it again. 
2. Copy the entire old http:// local folder with Explorer, not FrontPage, to the new one. 
3. Open the new one again in FP. If told that it is not FP web, confirm conversion. 

Alternatively, you can simply copy the ENTIRE folder from the local http location into a new location
and open it with the "More webs" button. Type the path without specifying the file:// prefix. This 
does not add the web to the Open List.

NOTE: It is not possible to open the local http folder directly by specifying it's path in this dialog 
box. The message "The folder ... is part of a server-based web" will appear.

WARNING: DO NOT USE FrontPage's Import File or Web command, because this does not 
properly copy _vti_pvt (hidden folder) where the Navigation, Design and Task Information is stored!
And: do not try to "Publish" to file://

As long your Web is accessible on the filesystem, including network drives, and not (only) on an
HTTP server, KISSfp can process it. So it is not absolutely necessary to convert your FrontPage Web

into a file-based one to use KISSfp but, for convenience, it's recommended.

However, if your Web does rely on Run-time Components, it makes no sense to use KISSfp as such a 
Web depends on the Server Extension. (Note that "Server-/File-based Webs" and "Webs using Run-Time 
components" are related, but not identical, issues.)



Image Maps

KISSfp can be used for Webs with image maps. (You should be aware and understand the difference 
between client-side and server-side image maps. Consult HTML literature for more information on this 
topic.)

It is strongly recommended for various reasons to always use client-side image maps. FrontPage will
generate correct <MAP> & <AREA> etc. tags automatically if the "client-side" check box is turned on in:

FrontPage (Explorer) : Extras / Web Settings / Extended Options

The easiest option is to use only client-side image maps, and no server-side. FrontPage will not generate
tags for server-side image maps if "type" is set to "none" in the above dialog. Note that you should 
always provide alternative textual links somewhere for any page linked by an image map, anyway. 
(See the Note in Crawling Details.)

However, if for some reason you want to enable NCSA, CERN or Netscape server-side image maps 
additionally to the client-side tags, it is possible as well. The correct CGI must be uploaded and set up 
manually though. In this case, the ERROR #9: Could not read e.g. 
"cgi-bin/imagemap/kissbots/_derived/image map.html.map can be ignored!

Note that FrontPage server-side image maps require the Server Extensions to be installed. For this 
reason, KISSfp will display the ERROR #30: Document "image map.html" uses FrontPage RunTime 
Component! and not process the Web!
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